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1 Welcome to GUITAR RIG SESSION!

GUITAR RIG SESSION is the perfect recording solution for guitarists, bass players and song-
writers. It consists of two products: the compact audio-interface GUITAR RIG SESSION 1/0
and the Essential version of the digital guitar studio GUITAR RIG 4.

The GUITAR RIG SESSION 1/0 is a high quality audio interface designed and optimized for
use with GUITAR RIG 4. It is a professional soundcard featuring a microphone preamplifier
with phantom power and two inputs for connecting electric guitars and basses as well as
line-level sources. A two-channel line out connects to your monitoring system, a stereo jack
allows for headphone monitoring at an independent volume.

The compact and robust metal casing is built to last under any conditions, from your daily
desktop routine to the strains of on-stage use.

In the following chapters you will learn more about the GUITAR RIG SESSION 1/0 and how
to make the best use of it. Please read this manual carefully in order to get acquainted with
the product.

GUITAR RIG SESSION -6



2 Before you Start — Important Notes

First things first; before using GUITAR RIG SESSION, it is advised that you read this chapter
carefully.

2.1 Serial Numbers & Nameplate

GUITAR RIG SESSION comes with two serial numbers. The GUITAR RIG SESSION /0 serial
number can be found on the bottom of the hardware, along with the nameplate listing the
product model name and other technical information. The serial number for activating GUITAR
RIG 4 is located on the cover of the product disc.

2.2 Using the Unit Safely

Please read the following instructions thoroughly to prevent from health risks and damaging
the product.

2.2.1 Warning

To prevent hearing damage, always follow these important security advices:

e This Product, in combination with an amplifier, headphones or speakers, can produce
sounds in decibel ranges that may cause hearing damage.

e For protection, set all volume levels to a minimum before using GUITAR RIG SESSION /0.
Gradually raise the volume while music is playing to set the desired listening level.

e Do not operate it at high volume levels for long periods. If you experience any hearing prob-
lems or ringing in the ears, consult an audiologist immediately.
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2.2.2 Caution

To make sure that the GUITAR RIG SESSION 1/0 or any device connected is not damaged
during usage or maintenance, it is important that you follow these instructions:

e Do not open the device or attempt to disassemble or modify the internal parts. The device
contains no user-serviceable parts. If it appears to be malfunctioning, discontinue use im-
mediately and have it inspected by qualified service personnel.

e Do not expose the unit to rain, use it near water or in damp or wet conditions.
e Do not allow any objects or liquids of any kind to penetrate the unit.

e Never use or store the unit in areas that are subject to temperature extremes (e.g. direct
sunlight in an enclosed vehicle or near heat-generating equipment) or high levels of vibra-
tion.

e Do not place the GUITAR RIG SESSION I/0 in an unstable position where it is possible the
unit could accidentally fall. Remove all connected cables before moving the unit.

e Before turning the power on or off for any component, set all volume levels to their minimum.
® Do not use excessive force on the knobs or connectors.

e When cleaning the GUITAR RIG SESSION 1/0, use a soft, dry cloth. Never use paint thin-
ners, solvents, cleaning fluids or chemical-impregnated wiping cloths.

2.2.3 Disposal Notice

Should this product become damaged beyond repair, or if you wish to dispose it, please ob-
serve the regulations of your area and country that relate to the disposal of electronic products.

2.3 Disclaimer

Native Instruments GmbH cannot be held responsible for damage or lost or destroyed data
caused by improper use or modification to the GUITAR RIG SESSION I/0.
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The information contained in this manual is believed to be correct at the time of printing or
digital release. However, Native Instruments reserves the right to make changes to the speci-
fications at any time without notice or obligation to update existing units.
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3 The SESSION I/0 Hardware

This section will give you an overview of the SESSION 1/0 hardware.

3.1 Front Panel

1 The Mic input accommodates XLR plugs (balanced). It connects your microphone to the
unit’s preamp for Input 1. Please enable phantom power for condenser microphones.

2 The socket for Input 1 (4" jack, TRS balanced) will accept line level or instrument level
signals, depending on the position of the Line/Inst switch. Connect a guitar, bass guitar,
keyboard or the left channel of a stereo device.

3 The socket for Input 2 (4" jack, TRS balanced) will accept line level or instrument level
signals, depending on the position of the Line/Inst switch. Connect a guitar, bass guitar,
keyboard or the right channel of a stereo device.

] Note that this input has priority over the XLR input (1). When in use, the XLR input is
= automatically disabled.
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4  This knob controls the gain of Input 1.
9 This knob controls the gain of Input 2.

6 The Inst/Line switch sets the input sensitivity for Input 1 and 2. When depressed, the
inputs will handle instrument signals such as a guitar or bass, when pressed, line level
signals are accepted. The selected input type is also indicated on the unit’s top.

1 This knob adjusts the level for Output 1/2.
8 The headphones jack connects your stereo headphones.
9 This knob adjusts the level for the headphones output.

3.2 Top Panel

& Guitar Rig session .';"L—;_-‘ [En

1 This shows the selected input signal type (Mic, Instrument, Line) for Input 1.
2 This LED shows a present signal at Input 1 / Input 2.
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3 This LED indicates clipping at Input 1 / Input 2 and therefore should not be lit when you
play.

4  This shows the selected input signal type (Instrument, Line) for Input 2.

9 This LED shows whether phantom power is activated.

3.3 Rear Panel

1 These jacks transmit the signal received from your computer. The TRS outputs work with
balanced and unbalanced connectors. Make sure both are connected for stereo sound.

2 This port accepts a Kensington™-compatible security cable lock. Use this to secure your
unit from theft.

3 The USB port connects the unit to your computer. Your computer must support USB
2.0 in order to work with GUITAR RIG SESSION [/0. The unit also relies on the USB bus
power to function. Connect this unit directly to your computer’'s USB 2.0 port and avoid
using un-powered USB hubs.

4 The 48V Phantom Power switch will apply phantom power to the XLR microphone input
(1). Condenser microphones rely on phantom power while other microphones don’t. Make
sure that phantom power is turned off before connecting a dynamic or ribbon microphone
Is connected to prevent serious damage.
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4 Installation under Windows XP / Windows Vista

This chapter describes the installation of the SESSION [/O hardware under Windows XP and
Windows Vista.

For detailed information about the GUITAR RIG 4 software, please consult the Application
Reference. You can find it on the product CD or in the GUITAR RIG 4 menu under Help >
Open Manual > Your Language.

4.1 Software Installation

Make sure that you are logged in with administrator privileges. Don’t connect the GUITAR
RIG SESSION 1/0 yet.

1. Browse the content of the product CD and locate the setup file. It is called “Guitar Rig
4 Setup”. If you are using a download version of GUITAR RIG 4, you need to extract the
setup files first.

2. Double-click “Guitar Rig 4 Setup” to start the installation procedure.
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D Mative Instruments Guitar Rig 4 - Installiware Wizard E]|§||g|

Welcome to the Native Instruments
Guitar Rig 4 Setup

Mote: &fter installation, do not move or rename the application
or the installation directory of the application, Otherwise, wou wil
nat be able ta run update installers,

Please make sure that the Guitar Rig 4 hardware is
not connected during this installation!

To conkinue, click Mext,

Mext = ] l Cancel

Follow the on-screen instructions that will guide you through the installation procedure.

You will be asked to specify the path to the plug-in folder of your DAW (Digital Audio
Workstation, e.g. your sequencer software). If you will use GUITAR RIG 4 exclusively in
standalone mode, or if you don’t know what a plug-in is, just use the standard setting.

You will be asked if you want to install drivers for the GUITAR RIG audio interfaces. Select
“Session 1/0” and click on “Continue.”

During installation of the driver, several Windows security messages will show up, e.g. “The
driver has not passed the Windows Logo Test” or “Windows can’t verify the publisher of
this driver software”. Don’t worry, everything is fine here. Simply click “Continue anyway”
(Windows XP) or “Install this driver software anyway” (Windows Vista) to continue the
Installation.
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Software Installation

' E The software you are installing has not passed Windows Logo
= testing to verfy its compatibility with YWindows XP. (Tel me why
this testing is importart )

Continuing your installation of this software may impair
or destabilize the comect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the software vendor for software that has
passed Windows Logo testing.

[ Continue Amyway l [ STOP Installation

1. Restart your computer upon completion.

The following applications have been placed onto your hard drive:
e GUITAR RIG 4 - the fully featured standalone application.

e GUITAR RIG 4 plug-ins — Use GUITAR RIG 4 as a plug-in for your Digital Audio Workstation
(DAW) of choice. On Windows computers, GUITAR RIG 4 supports the VST and RTAS®
plug-in formats.

e Native Instruments Service Center — this application handles product activation as well as
update management. Please refer to the Setup Guide for details.

e The drivers for the GUITAR RIG SESSION 1/0 audio interface.

If you have never owned a Native Instruments product, you will need to register by following

the on-screen instructions. More information about creating a NI User Account and about
activating GUITAR RIG 4 is available in the Service Center Quick Start Guide and manual located in the
Service Center installation folder.
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In case you want to install the hardware drivers only, a separate driver installer file is available
on the installation CD. You can also download its latest version from the Support section of
the Native Instruments website.

4.2 Hardware Installation

Use the supplied USB cable to connect the SESSION 1/0 directly to a USB 2.0 port on your
computer.

The SESSION 1/0 is powered via USB. Operation is guaranteed only with a USB 2.0 controller
as a single device or with self-powered USB 2.0 hubs. On Windows XP systems, Service Pack
2 or higher is required for the SESSION 1/0 to work — you can find out about your Windows
version in the System Properties window.
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Systemn Hestore Automatic Updates

General Computer Name

N
s

_ﬁ_'

System:

Microsoft Windows XP
Professional

Wersion 2002

Service Pack 3

Feaistered to:

Dell Latitude D&30

Intel{R) Core{TM)2 Dua CPL
T9300 @ 2 50GHz

249 GHz, 1.95 GB of RAM
Physical Address Bxtension

[ Support Infamation ]

| ok

H Cancel ]

Remote
Hardware Advanced

After successfully installing the driver, the SESSION 1/0 will be recognized automatically. If

not, start the software installation again as explained above.

Several driver modules will be assigned to the SESSION 1/0 now, each one causing a pop-up

window in which you are asked how you want to install the new device.
1.
2.

Choose not to connect to the “Windows Update Web site”.

Choose “Install the software automatically” (Windows XP) or “Locate and install driver

software” (Windows Vista).
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Found New Hardware Wizard

This wizard helps you install software far:

Sesgion /0

-\,.I if your hardware came with an installation CD
i or floppy disk. insert it now.

What do you want the wizard ta da?

{?} Install the software automatically (Recommended)
{0 Install from a list or specific location {Advanced)

Click Mext to continue.

¢ Back ][ Mead = ][ Cancel

3. Follow the on-screen instructions to complete this procedure.

4. The Windows security warning appears. Click “Continue anyway” (Windows XP) or “Install
this driver software anyway” (Windows Vista) to properly install the drivers.

On a Windows computer, the driver is associated with a particular USB port. If you plug the
USB cable into a different port than the one it was installed at, the driver assignment process
starts again — if this happens, just follow the steps described above.

If at any time the computer does not seem to recognize the SESSION 1/0, disconnect the USB
cable, wait a few seconds, then re-connect it. If the problem remains, restart your computer
with the interface connected.

4.3 Configuration
This chapter explains how to use the SESSION 1/0 audio interface with Windows XP / Vista

and particularly with GUITAR RIG 4. It is assumed that you have already activated GUITAR
RIG 4 using the Service Center — please refer to the Setup Guide for help on this process.
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4.3.1 Configuring GUITAR RIG 4

We will now set up GUITAR RIG 4 to use the SESSION 1/0 audio interface. Start the software
before you proceed.

1. When the software is started for the first time, you will be prompted with the Audio Setup
window automatically, where you need to make the following settings. To access these
settings later on, select File > Audio and MIDI Settings from the program menu.

Audio and MIDI Settings...

Routing MIDI .

Audio

Driver (Asio -]
Device ( AsIO Config | [ Session 1/0 -]
Status Running
Sample Rate (44100 -]
Latency 88 Samples
Input» 25 ms | Processing » 2.0ms | Output» 45ms | Overall » 9.0 ms

(O cancel | [ @oK |

2. On the “Audio” tab, choose ASIO as the “Driver” interface.
3. Select SESSION 1/0 from the “Device” dropdown menu.

If SESSION 1/0 does not appear in the list, something went wrong. Restart the installation
as explained above.

You can access the Driver Control Panel by clicking on “ASIO Config”. In the Driver Control
Panel, two status fields on the bottom show whether the SESSION 1/0 hardware is connected
and ready to use.
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Oi Native Instruments Session 1/0 Control Panel E|§|@

Soundcard Latency Settings

Fresets: |minimal latency (low CPU uzage situation) j

Thiz setting offers a minimunn output latency of ~8 me [3 ms input to
autput] but should only be uzed in zituations with low CPL uzage.

LISE Buffersize: Audio Buffersize;

Buffer Format

Sample Fate: |44‘||:||:|H3 --|

Ahout

Ready connecked

The audio interface allows to be configured by the following parameters:

e Presets: Several presets for common types of usage are included, from minimal latency
suitable for fast systems with strong CPU power, to higher latencies suitable for slower sys-
tems. If you are experienced in setting up audio drivers and want to create your own custom
settings, select User Defined Settings (see next).

e USB Buffersize and Audio Buffersize: These parameters are grayed out, unless you have
selected User Defined Settings from the Presets Menu. Together, they define the system’s
latency, i.e. the time that passes from the moment an audio signal is sent into the SESSION
I/0 hardware until the moment you hear it in your headphones or your speakers. The value
for Audio Buffersize must always be at least twice as large as the USB Buffersize value. Note
that the USB Buffersize parameter has a direct impact on the CPU usage of the system.
The resulting CPU usage differs between computers, so it could make sense to experiment
with different settings.

e Sample Rate: Choose a sample rate that is compatible with your music application and
suited to your computing power. Per default, the sample rate is set to 44100 Hz (CD-Quality).
Higher sample rates may improve sound quality, but cause a higher CPU load as well.
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It is recommended that you try the latency presets first and then continue with the subse-
quent steps of the installation. Once you are finished, you should revisit the Audio and MIDI
Settings to figure out the best latency setting for your system. If audio dropouts occur with
the preset minimal latency, try the low latency or standard latency settings. Higher latency
values will reduce the probability of audio dropouts.

4.3.2 Using the SESSION 1/0 as your Default Audio Interface

If you want to use the SESSION /O for playback of all audio applications on your computer
(not only for music software), you have to set it as your default audio interface.

For Windows XP, this works as follows:
1. Open Start > Control Panel > Sounds and Audio Devices.
2. Select the “Audio” tab.

3. In the “Sound playback” and “Sound recording” sections, click on the Default Device
menu, and then select SESSION 1/0.

4. Click OK to close the “Sounds and Audio Devices” dialog.
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Sounds and Audio Devices Properties @E|

YWolume Sounds Audio Woice Hardware

Sound playback
Default device:
>/

Seszzion | /0 Output L

Yolume... ] [ Advanced. ..

Sound recording

ﬁ Detautt device:
Sezzion A0 Input L

MIDI music playback

% Diefault device:

=9 | Microsoft GS Wavetable SW Synth v

[ Yolume. .. ] [ About ...

[ ] Use orly default devices

| ok || camesl || tepb |

For Windows Vista, this works as follows:

1. Open Start > Control Panel > Hardware and Sound > Sound.

2. Select the “Playback” tab.

3. In the device list, select SESSION 1/0 and click on “Set Default.”
4. Select the “Recording” tab.

9. In the device list, select SESSION 1/0 and click on “Set Default.”
6. Click OK to close the dialog.
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4.4 Audio Connections and Levels

In the following chapters you will learn how to connect your guitar and your monitoring system
to the SESSION 1/0 and how to set the right amplification levels both on the hardware and
on the software side of your setup.

Please start GUITAR RIG 4 before you proceed.

4.4.1 Connecting your Instrument and Adjusting the Input Level
1. Turn down the volume on your monitoring system to prevent hearing damages.

2. Make sure the input selector is set to “Instrument” (button not depressed) except if you
are using a preamp to boost your signal to line level.

3. Plug the cable connected to your guitar or bass into one of the input jacks of the SESSION
/0.

4. Completely turn down the volume of the input channel you are not using.

Mind that for an instrument that generates a stereo signal, such as a synthesizer keyboard,
you need to connect it to both input channels for stereo sound.
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In order to achieve the best sound quality by providing the interface with a sufficiently power-
ful signal, you need to carefully adjust the input level of the SESSION 1/0.

The Input LEDs help you by indicating the level of the incoming signal for each channel:

LED Status Meaning

LED is off No incoming signal

LED flashing green Incoming signal

LED flashing red Incoming signal is too loud

Before adjusting the input sensitivity, turn up the volume knob on your guitar. Strum some
chords at the volume level you are typically playing at and look at the Input LEDs for the
channel you are using:

1. Turn up the according input level knob just until the red Clipping LED is lit when you play.

2. At that point, slightly turn the knob down until the Clipping LED is always off, even when
you are playing really powerful chords.

Now the input sensitivity is set to its optimum level, enabling the SESSION 1/0 to provide the
highest dynamical range without clipping.

4.4.2 Connecting a Second Instrument

You can connect different instruments to the input channels, as long as they both provide a
signal at the same level (line or instrument). Just plug the cable of your second instrument
into the other input jack and set the right input level as described in the previous section.

For instruments generating a stereo signal, the second channel needs to be connected for
stereo sound.
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4.4.3 The Input Level of GUITAR RIG 4

It Iis assumed that your guitar is connected to the SESSION 1/0 and its input level is properly
adjusted (see section 4.4.1). Now we need to make sure that the input signal is processed
at the right level by the software.

Please take a look at the header of the GUITAR RIG 4 window: It consists of the input mod-
ule with channel selectors (L/R), a basic noise gate, the output module with a limiter and
information about the processing power consumed.

For a detailed description and explanation of the Noise Reduction circuit, please consult
the GUITAR RIG 4 Application Reference included on the product CD.

Note that the Input Meter shows an amplitude when you play. It also features an integrated
volume fader that controls the input level of the software. Please adjust it to achieve the
highest possible level for your signal without clipping. This is indicated by the Level Meter
getting close to the red zone without actually hitting it.

If only one guitar is connected, GUITAR RIG 4 will receive a mono signal. You can set up the
Input module to route your guitar signal to both channels. Per default, GUITAR RIG 4 is set
to process both input channels (L + R are activated), so one of the input channels remains
mute. To change this, deactivate the channel you are not using: Click on the appropriate but-
ton (L or R) on the left hand side of the Input Meter once, so that only the input channel in
use is active. This will route the mono signal to both channels.

4.4.4 Connecting the Output

The SESSION 1/0 provides two mono outputs (L/R) to connect your monitoring system, be
it a mixing desk, a pair of active speakers or your home stereo. Mind that both of them have
to be connected for stereo sound. A separate stereo output (TRS) allows for connecting your
headphones.
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1. Connect the output jacks to the input of your amp with its volume set to your usual level
and the output level knob turned down.

2. If you are using headphones, connect them to the output jack and put them on with the
headphone level fully turned down.

3. Go to the Preset Browser and select any of the presets by clicking on it. Start playing and
carefully turn up the output or headphone level of the SESSION 1/0 to the desired level.

If your instrument uses only one channel, set the other channel’s Gain Knob to zero.

You're all set now and ready to rock!
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5 Installation under Mac 0S X

This chapter describes the basic installation of the SESSION I/O hardware under Mac OS.

For detailed information about the GUITAR RIG 4 software, please consult the Application
Reference. You can find it on the product disc or in the GUITAR RIG 4 menu under Help >
Open Manual > Your Language.

5.1 Software Installation

Make sure that you are logged in with administrator privileges. Don’t connect the SESSION
/0 yet.

1. Browse the content of the product CD and locate the file “Guitar Rig 4 Installer”. If you
are using a download version of GUITAR RIG 4, you need to extract the installer file first.

2. Double-click the installer file to start the installation procedure.

a0O0 < Install Guitar Rig 4

Welcome to the Guitar Rig 4 Installer

@ Introduction

Mote: Afterinstallation, do not move of rename the
application or the installation directory of the
application. Otherwise, you will not be able to run
update installers.

(vI

H
~ Continue
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3. Follow the on-screen instructions that will guide you through the installation procedure.

4. You will be asked if you want to install drivers for the GUITAR RIG audio interfaces. Select
“Session 1/0” and click on “Continue”.

9. Restart your computer upon completion.

The following applications will be placed onto your hard drive:
e GUITAR RIG 4 - the fully featured standalone application.

e GUITAR RIG 4 plug-ins — use GUITAR RIG 4 as a plug-in for your digital audio workstation
(DAW) of choice. On computers running Mac OS X, the VST, AU and RTAS® plug-in formats
are supported.

® Native Instruments Service Center — this application handles product activation as well as
update management. Please refer to the Setup Guide for details.

e The drivers for the SESSION /O audio interface.

If you have never owned a Native Instruments product, you will need to register by following

the on-screen instructions. More information about creating a NI User Account and about
activating GUITAR RIG 4 is available in the Service Center Quick Start Guide and manual located
in the Service Center installation folder.

In case you want to install the hardware drivers only, a separate driver installer file is available
on the installation CD. You can also download its latest version from the Support section of
the Native Instruments website.

5.2 Hardware Installation

Use the supplied USB cable to connect the SESSION 1/0 directly to a USB 2.0 port on your
computer.
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The SESSION 1/0 is powered via USB. Operation is guaranteed only with a USB 2.0 controller
as a single device or with self-powered USB 2.0 hubs.

After successfully installing the driver, the SESSION 1/0 should be recognized automatically.
If at any time the computer does not seem to recognize the SESSION 1/0, disconnect the
USB cable, wait a few seconds, then re-connect it. If this does not solve the problem, restart
your computer with the interface connected.

9.3 Configuration

This chapter explains how to use the SESSION 1/0 audio interface under Mac OS X and
particularly with the included GUITAR RIG 4. It is assumed that you have already activated
GUITAR RIG 4 using the Service Center — please refer to the Setup Guide for help on this
process.

9.3.1 Configuring GUITAR RIG 4

We will now set up GUITAR RIG 4 to use the SESSION 1/0 audio interface. Start the software
before you proceed.
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1.

2.
3.

Audio ‘ Routing MIDI (v
Driver [ CoreAudio -
Device [ Session 1/0 (2 In, 2 Out) -]
Status Running
Sample Rate (44100 -
Latency 512 Samples [ [ ] )
Input » 16.0 ms | Processing » 11.6 ms | Output » 5.8 ms | Overall » 33.4 ms

| ©cancel | [ @oKk |

On the Audio tab, choose CoreAudio as the “Driver” interface.
Select SESSION /0 from the “Device” dropdown menu.

When the software is started for the first time, you will be prompted with the Audio Setup
window automatically, where you need to make the following settings. If you want to ac-
cess these settings later, select GUITAR RIG 4 > Preferences from the program menu.

| e Audio and MIDI Settings...

If SESSION 1/0 does not appear in the list even though it is connected, something went wrong.
Restart the installation as explained in section 5.1.

The audio interface allows to be configured by the following parameters:

Sample Rate: Choose a sample rate that is compatible with your music application and suited
to your computing power. Per default, the sample rate is set to 44100 Hz (CD-Quality). Higher
sample rates may improve sound quality, but cause a higher CPU load as well.

Latency: Use the Latency slider to set the buffer size of the audio interface, measured in
samples. The buffer size has two effects: The higher it is set, the lower is the probability of
dropouts during real-time audio processing. On the other hand, the size of the buffer di-
rectly affects the overall latency of your system. The time between the moment you hit a
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note and the moment you hear the processed sound will be longer if the buffer size is in-
creased.

It is recommended that you start with the default buffer size and continue with the subse-
quent steps of the installation. Once you are finished, you should load a clean preset and
revisit the Audio and MIDI Settings to achieve the best latency setting for your system. This
Is done by gradually reducing the buffer size: Drag the latency slider to the left while playing
something. Once you begin to hear crackles or dropouts, carefully drag the latency slider to
the right until you reach the point where no crackles or dropouts occur.

9.3.2 Using SESSION 1/0 as your Default Audio Interface

If you want to use the SESSION /O for all audio playback (not only for music software), you
have to set it as your default audio interface. For Mac OS X, this works as follows:

1. From the Apple menu, select System Preferences.
2. In the panel that opens, click on “Sound.”

800 Sound

(o] CE—

[ Sound Effects | Output  Input |

Choose an alert sound

| Name Type

Basso Built-in m
Blow Built-in

Bottle Built-in

Frog Built-in

Play alerts and sound effects through: | Session 1/0 F

Alert volume: of ) 4)))

™ Play user interface sound effects

E Play feedback when volume is changed

&)

E Play Front Row sound effects

Output volume: o

| ) | | | *))) M Mute

EShow volume in menu bar
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3. On the Sound Effects tab, select SESSION 1/0 in the “Play alerts and sound effects
through” menu.

4. Click on the Output tab, and then select SESSION 1/0O from the “Choose a device for
sound output” list.

9. Click on the Input tab, and then select SESSION 1/0 from the “Choose a device for sound
input” list.

9.4 Audio Connections and Levels

In the following chapters you will learn how to connect your guitar and your monitoring system
to the SESSION /0 and how to set the right amplification levels both on the hardware and
on the software side of your setup.

Please start GUITAR RIG 4 before you proceed.

9.4.1 Connecting your Instrument and Adjusting the Input Level
1. Turn down the volume on your monitoring system to prevent hearing damages.

2. Make sure the input selector is set to “Instrument” (button not depressed) except if you
are using a preamp to boost your signal to line level.

3. Plug the cable connected to your guitar or bass into one of the input jacks of the SESSION
/0.

4. Completely turn down the volume of the input channel you are not using.

Mind that for an instrument that generates a stereo signal, such as a synthesizer keyboard,
you need to connect it to both input channels for stereo sound.
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In order to achieve the best sound quality by providing the interface with a sufficiently power-
ful signal, you need to carefully adjust the input level of the SESSION 1/0.

The Input LEDs help you by indicating the level of the incoming signal for each channel:

LED Status Meaning

LED is off No incoming signal

LED flashing green Incoming signal

LED flashing red Incoming signal is too loud
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Before adjusting the input sensitivity, turn up the volume knob on your guitar. Strum some chords
at the volume level you are typically playing at and look at the Input LEDs for the channel you
are using:

1. Turn up the according input level knob just until the red Clipping LED is lit when you play.

2. At that point, slightly turn the knob down until the Clipping LED is always off, even when
you are playing really powerful chords.

Now the input sensitivity is set to its optimum level, enabling the SESSION /O to provide the
highest dynamical range without clipping.

9.4.2 Connecting a Second Instrument

You can connect different instruments to both input channels, as long as they both provide
a signal at the same level (line or instrument). Just plug the cable of your second instrument
into the other input jack and set the right input level as described in the previous section.

For instruments generating a stereo signal, the second channel needs to be connected for
stereo sound.

9.4.3 The Input Level of GUITAR RIG 4

It is assumed that your guitar is connected to the GUITAR RIG SESSION 1/0 and its input
level is properly adjusted (see section 4.4.1). Now we need to make sure that the input signal
Is processed at the right level by the software.

Please take a look at the header of the GUITAR RIG 4 window: It consists of the input mod-
ule with channel selectors (L/R), a basic noise gate, the output module with a limiter and
information about the processing power consumed.

For a detailed description and explanation of the Noise Reduction circuit, please consult
the GUITAR RIG 4 Application Reference included on the product CD.
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Note that the Input Meter shows an amplitude when you play. It also features an integrated
volume fader that controls the input level of the software. Please adjust it to achieve the
highest possible level for your signal without clipping. This is indicated by the Level Meter
getting close to the red zone without actually hitting it.

If only one guitar is connected, GUITAR RIG 4 will receive a mono signal. You can set up the
Input module to route your guitar signal to both channels. Per default, GUITAR RIG 4 is set
to process both input channels (L + R are activated), so one of the input channels remains
mute. To change this, deactivate the channel you are not using: Click on the appropriate but-
ton (L or R) on the left hand side of the Input Meter once, so that only the input channel in
use is active. This will route the mono signal to both channels.

9.4.4 Connecting the Output

The SESSION 1/0 provides two mono outputs (L/R) to connect your monitoring system, be
it a mixing desk, a pair of active speakers or your home stereo. Mind that both of them have
to be connected for stereo sound. A separate stereo output (TRS) allows for connecting your
headphones.

Y

1. Connect the output jacks to the input of your amp with its volume set to your usual level
and the output level knob turned down.
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2. If you are using headphones, connect them to the output jack and put them on with the
headphone level fully turned down.

3. Go to the Preset Browser and select any of the presets by clicking on it. Start playing and
carefully turn up the output or headphone level of the SESSION 1/0 to the desired level.

If your instrument uses only one channel, set the other channel’s Gain Knob to zero.

You're all set now and ready to rock!
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6 Troubleshooting

Should you encounter any problems with your hardware, it is recommended that you follow
these steps to find a solution to your problem before contacting Technical Support:

e Visit NI's online Knowledgebase. The easiest way to find it is by selecting Help > Visit the
Knowledgebase... from the GUITAR RIG 4 menu.

e Visit the NI User Forum on our website (http://www.native-instruments.com/forum/) and
perform a search for helpful answers from the GUITAR RIG user community.

When contacting Technical Support, please make sure to have all relevant information about
your computer at hand. For information about the driver’s version and the firmware revision,
please check the Driver Control Panel.

e  On Windows computers you find it in the GUITAR RIG 4 application folder in the Start menu.
The information is shown after you click on “About”.

e On Mac OS X computers, you can access the Driver Control Panel from the system prefer-
ences. The information is shown in the main window.

Please visit this URL to contact the support team:
http://www.native-instruments.com/support/

All products by Native Instruments are tested extensively in real life situations during the
development phase. However, if your product needs to be returned, the Technical Support
team will assign you an RA (Return Authorization) number to expedite the processing of your
return. Please contact our Technical Support team prior to returning any item. Packages
returned without this RA number will not be correctly identified and as such might not be
processed efficiently.
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6.1 Audio Issues

This section provides help with the most common audio issues you may encounter.

6.1.1 No Sound or Low Volume
There are several possible reasons for a silent or low audio output:

Disconnected or broken cables. Please check all connections and cables.

Incorrect soundcard or audio input selected. Please check the Audio and MIDI Settings in
the GUITAR RIG 4 menu if the SESSION /O driver is selected.

Wrong channel selected in the Input Module of GUITAR RIG 4. Either connect your instru-
ment to the other input jack or switch to the other channel by choosing “L” in the INPUT
Module.

The SESSION 1/0’s input gain is set too low. Turn up the according Input Level.

Your instrument’s volume is turned down. Turn up the volume knob.

6.1.2 Distorted Signal

If the audio signal sounds distorted, and no distortion is being added by the GUITAR RIG 4
software, then this is most likely caused by the SESSION 1/O’s gain being set too high. Reduce
the Input Level at the Interface to prevent the preamp from clipping. If your instrument deliv-
ers such a high signal that the preamp is always overdriven, you should reduce its volume.
Usually, this only happens if the instrument is equipped with special high power pickups.

6.1.3 Noise

Audible hum can have several reasons, some of which are listed below:

Single-coil pickups are prone to collecting electrical interferences. Humbucker pickups
produce much less hum, which is why they got their name.

Your guitar is too close to electrical equipment. To reduce this type of hum, move the guitar
further away from the equipment.
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e The guitar’s volume knob is set to a low level. Turn the knob up. If your guitar has more than
one volume knob, make sure to check all knobs.

e You are using a non-shielded or broken guitar cable. Your guitar’s shielding may also be
insufficient. Try replacing the cable with a shielded model first. If this does not help, you
should consider having your guitar’s electronics serviced and shielded by a professional.

If you're experiencing hiss, the input level at the SESSION /O preamp might be too low.
Turn up the instrument’s volume or increase the input level on the SESSION /0. For more
information on setting the input level, see section 4.4 (Windows XP/ Windows Vista) or sec-
tion 5.4 (Mac OS X) of this manual.

6.1.4 Ground Loops

Ground loops (usually perceived as a hum or buzz) are a common problem when multiple
electrical devices are connected to the same power circuit. The following steps should help
to eliminate them:

e Disconnect all devices that you are not currently using, e.g. peripheral devices you may have
connected to your computer (external data storage, CD burners).

e Hook up a DI box behind the SESSION 1/0 outputs. Most of these boxes have a ground lift
switch, which allows breaking the ground loop and eliminating the noise.

6.2 Hardware-Related Problems

Check the Native Instruments website and the NI Service Center for updates of the SESSION
I/0 driver and more information.

6.2.1 Driver Issues

Make sure that the SESSION 1/0 is connected to the computer and open the Driver Control
Panel. See the intro to this chapter on how to find the Control Panel.
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If the Control Panel is missing, the driver is most likely not installed at all. In this case, please
re-install the driver as described above.

If all the drop-down menus of the Control Panel are grayed out, the SESSION 1/O is not rec-
ognized by the driver. Something might be wrong with the USB connection, see the following
sections for details.

6.2.2 USB Issues

The SESSION 1/0 is a USB 2.0 interface and will not work on a USB 1.0/1.1 port. Always
connect it directly to a USB 2.0 port on your computer. The port needs to fulfill the minimum
power specification for a USB 2.0 port (500 mA). On certain computers, the USB 2.0 ports
do not meet the official USB 2.0 power specification. In this case, you may see a message,
saying that there is not enough power available to operate your device. The SESSION [/0 may
produce crackles or may not work at all.

e |f your computer is unable to supply the necessary amount of bus power, try connecting
your SESSION 1/0 to a USB 2.0 hub with external power-supply. Avoid connecting other
devices to the hub, as every bus-powered device will diminish the total amount of power
available.

® |n case of failures, it is useful to check if SESSION 1/O works if you disconnect any other
USB device from the computer.

e |f you are experiencing audio dropouts or other problems that may be related to the USB
connection, try connecting the SESSION 1/0 to another USB 2.0 port.

e A bad USB cable can be responsible for audio dropouts and/or other connectivity problems.
Try using a different cable bearing the official USB logo, in some cases using a shorter
cable might help.

e |f you are experiencing problems with SESSION 1/O crashing or performing badly on a
Windows machine, the first thing to do is to disable power management for the USB hubs,
which is turned on by default. Go to the Device Manager (Control Panel > System >
Hardware) and right click a USB hub to bring up its properties. On the Power Management
page, uncheck all boxes. Repeat for each hub and reboot.
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6.2.3 Using the SESSION 1/0 with a Laptop

Please check if your computer is suited for handling real-time audio processing without drop-
outs. There are a couple of freeware tools to analyze your system, for example:

www.thesycon.de/deu/latency_check.shtml

Start the tool with the SESSION 1/0 disconnected. In case your computer is unable to handle
glitch-free audio processing, the tool will show red latency bars and report this in the box on
the bottom.

In general, it is not recommended to use laptops with shared-memory graphic cards. You will
need all the memory and processing power available for your audio project.

There are some steps to optimize your laptop’s audio performance:

e |t is not recommended to run the laptop on battery, as power management might slow the
clock rate of the CPU down to save battery.

® Disconnect all unused hardware (e.g. printer, scanner). This will increase the amount of
processing power available for your music software.

e | aptops often are equipped with built-in devices that disturb audio processing, most com-
monly a network adapter or a wireless LAN card. You might need to disable these devices
while working with GUITAR RIG SESSION.
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1 Technical Specifications

This section contains all relevant technical specifications of the SESSION [/O hardware.

1.1 Jacks and Sockets

e 2 input jacks (In 1, In 2) for mono ¥4” jacks (6.3mm plugs)

e 2 output jacks (Out 1, Out 2) for ¥4” (6.3mm) mono (unbalanced) or TRS (tip/ring/sleeve

balanced) plugs

e 1 Headphones jack for stereo 4" (6.3mm) jack

e 1USB20TypeB

1.2 Audio Specifications

Audio Inputs (A/D)

Channels 2

Sample Rate 441, 48, 88.2, 96, 192 kHz
Bit Resolution 16, 24 Bit

Converter Cirrus Logic
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Mic Input

Input Impedance

4.8 kQ balanced

Full Scale Level at Max. Gain -46 dBu
Maximum Input Level O dBu
THD+N 0.008%

Frequency Response

10 - 40000 Hz (-1 dB)

Line Input

Input Impedance

44 kQ unbalanced & balanced

Full Scale Level at Max. Gain

-2.19 dBu

Maximum Input Level

+15 dB unbalanced and balanced

SNR (weighted)

96.2 dB

THD+N

0.008%

Frequency Response

10 - 40000 Hz (-1 dB)
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Instrument Inputs

Input Impedance

1 MQ unbalanced

Full Scale Level at Max. Gain

-8.3 dBu

Maximum Input Level

+9 dB unbalanced

SNR (weighted)

95.9 dB

THD+N

0.008%

Frequency Response

10 - 40000 Hz (-1 dB)

Audio Outputs (D/A)

Channels 2

Sample Rate 441, 48, 88.2, 96, 192 kHz
Bit Resolution 16, 24 Bit

Converter Cirrus Logic

GUITAR RIG SESSION - 44



Line Outputs

Output Impedance

100 ohms unbalanced, 200 ohms balanced

Maximum Qutput Level +6 dBu
SNR (weighted) 100 dBu
THD+N 0.008%

Frequency Response

10 - 45000 Hz (-0.5 dB)

Headphone Output

Load Impedance

8 - 600 ohms

Maximum Output Level

1.67 V eff @ 100 ohms

SNR (weighted)

98.2 dB

THD+N (60 Ohms)

0.008%

Frequency Response

10 - 40000 Hz (-1 dB)
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1.3 Power Supply

Via USB 2.0 interface, 5V/ 500mA bus power

No additional power supply or battery is needed, only power from the USB is required.
However, proper operation is guaranteed only when SESSION /O is used as a single device
with a USB 2.0 controller, or with a self-powered USB 2.0 hub.

1.4 Dimensions and Weight

121 x 115 x40 mm (4.76 x 4.53 x 1.57 in)
0.56 kg (1.235 Ib)

1.9 Environmental Specifications

Operating temperature: 0°C to 40°C (32°F to 104°F) (85% non-condensing humidity)
Storage temperature: -20°C to 50°C (-4°F to 122°F) (85% non-condensing humidity)
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1.6 System Requirements

1.6.1 General System Specifications

e Windows® XP with Service Pack 2 or Windows® Vista™ (32/64 bit), Intel® Pentium™ or
AMD® Athlon™ XP 1.4 GHz, 1024 MB RAM, USB 2.0

e Mac OS® X 10.5, Intel® Core™ Duo 1.66 GHz, 1024 MB RAM, USB 2.0

1.6.2 Supported Driver Formats
e Mac OS® X: Core Audio™
e Windows®: ASIO® (recommended), DirectSound™, WASAPI™

1.6.3 Supported Platforms
¢ Mac OS® X: Stand-alone, VST®, Audio Units™, RTAS® (Pro Tools 7/8)
e Windows®: Stand-alone, VST®, RTAS® (Pro Tools 7/8)
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